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AIRCRAFT GENERAL DESCRIPTION

Pilatus announced the PC12 in 1989 and eventually the Swiss Federal Office of Civil Aviation
issued the type certificate for in March 1994.

Since entering service, Pilatus developed a large number of improvements and options upon the
original PC-12 model:

• Increases in the maximum takeoff weight
• Use of increasingly powerful engines
• New avionics
• Noise-reduction measures
• New propellers
• Speed and range increases
• Additional interiors
• New inflight entertainment systems.

Other aviation firms, such as inoff Aviation Products, have also produced their own independent
products and aftermarket enhancement packages for the PC-12.

Pilatus announced the PC-12NG (Next Generation) in 2006 and the first one was delivered in
2008. The NG features a more powerful Pratt & Whitney PT6A-67P engine that brings better
performance to the climb and cruise profile. The PC-12 was the only high-end single-engine
turboprop that lacked a full glass cockpit option. The NG was then designed to fill this gap,
featuring a full glass Honeywell Primus Apex cockpit.

The PC-12M (M for Multipurpose) is based on the PC-12 NG. It is equipped with a powerful
electrical generator. It allows additional power-consuming equipment to be used onboard.
This enables the PC-12M to perform missions such as flight inspection, air ambulance, aerial
photography, and aerial surveillance. An optional utility door accommodates parachute drops of
people and cargo. This version is marketed in the United States as the PC-12 Spectre paramilitary
special missions platform.
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INSTALLATION & CONFIGURATION

System requirements

This software requires X-Plane 11.00 or superior.

The minimum hardware requirements are the same of X-Plane:

• Dual Core, 2.5 GHz or faster
• 2 GB of RAM
• A video card with at least 500 MB of VRAM.

If you use REP under Linux, there are some addictional requirements:

• libstdc++6
• libgcc6
• libcurl
• libssl
• libcrypto

This software is designed to run on Windows, MacOS and Linux.

In order to install this software, the Pilatus PC-12 for X-Plane 11 by Carenado must be installed
on your system.

Install the software

Note: A video tutorial is available on our YouTube Channel

To install the software please follow this procedure.

1. Install the PC-12 in your X-Plane.
2. Clone the PC-12 folder and call it “PC-12 REP”.
3. Extract the contents of this REP package into a temporary folder
4. Move the contents of “into-aircraft-plugins-folder” into the “PC-12 REP/plugins” folder
5. Move the contents of “into-aircraft-main-folder” into the “PC-12 REP” folder
6. Run X-Plane and load the PC-12.
7. Follow the onscreen instructions
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Automatic Update of the Software

The Reality Expansion Pack support the automatic updates via the SkunkCrafts Updater plugin.
In order to activate the automatic updates you shall:

1. Install the SkunCrafts Updater plugin as stated in its user manual
2. Inside REP’s zip, inside the “into-aircraft-main-folder”, you find a file called skun-

crafts_updater.cfg. Copy such file into the PC-12 main folder.

NOTE

• Always install REP’s skunkcrafts_updater.cfg file even when the airplane already comes
with its own cfg. REP updates will automatically install the base airplane updates whenever
available.

• Load a non-REP airplane - such as the default Cessna 172 - before applying the automatic
updates. Applying the updates on the aircraft that is currently loaded in the sim will not
guarantee a successful update.

• After updating the plane, close and relaunch X-Plane to make sure that all the files are
unloaded and updated correctly.

Manual Update of the software

NOTE: It is not necessary to remove the older REP files. The software will take care of the update
procedure.

1. Copy the “REP” folder contained in this package inside the “plugins” folder of the PC-12,
overwriting the existing one.

2. Run X-Plane and load the PC-12.
3. Reload the aircraft when the automatic update is finished.

Remove the software

To remove the software follow this procedure:

1. In the menu bar click on “Plugins”
2. Click on “SimCoders.com - REP” and choose “Disable Package”
3. Click “Ok” in the confirmation message
4. Reload the aircraft when the uninstallation procedure ends

At the end of the uninstallation procedure, the original aircraft will be restored to its mint condi-
tions.
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Recommended sound settings

To better enjoy the Reality Expansion Pack on the PC-12, you should setup your sound settings
like the following screenshot.

Figure 1: Recommended sound settings

For more information about the sounds, see the Sounds System chapter.

Recommended control settings

To have a better control over the airplane axis, you should setup your control sensitivity as
follows.

Figure 2: Recommended control settings
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HARDWARE & SOFTWARE COMPATIBILITY

Headshake

If HeadShake v1.5 or higher is installed in your system, it will communicate with REP to improve
the simulation realism.

REP will drive HeadShake to simulate the vibrations of the real engine. Using this, you will be able
to run the engine at the most comfortable RPMs by simply checking the vibrations it produces.

In the same way, HeadShake will simulate the stall buffeting if the airplane in use shows that
kind of behavior.

Saitek Panels

This software is compatible with Saitek Panels. In order to use them, you should install the
XSaitekPanels free plugin from Sparker.

This package already includes a INI configuration file for XSaitekPanels. Make sure you copy it
inside the main folder of your PC-12.

XPRealistic

The Reality Expansion Pack can be used together with XPRealistic.

You might need to disable XPRealistic’s wind, touchdown and brakes sound effects as REP
already provides them.

Differential and progressive brakes for X-Plane 11

The Reality Expansion Pack detects if Differential and progressive brakes for X-Plane 11 is
installed in your system.

If so, REP’s differential braking algorithm is disabled in favor of the custom differential brakes
algorithm of the third party plugin.
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USER INTERFACE

Lateral Menu

When loaded, REP shows a lateral menu on the left-side of the screen. The menu consists of a
set of small icons.

By default, the menu partially hides itself until the mouse pointer gets near it.

Figure 3: The menu is partially hidden by default

Figure 4: The menu is shown when the mouse pointer gets closer to it

You can choose to completely hide the menu when the mouse pointer leaves it. To do so, go
to “Plugins -> SimCoders - REP -> Settings” menu and tick the “Show side menu on mouse over
only” option.

The lateral menu entries are available in the “Plugins -> SimCoders - REP” menu as well.
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Maintenance Report

This window is the primary way you have to check the status of your airplane and to fix all the
systems that need the mechanic attention.

The report is divided on more pages. Each page relates to a different group of systems.

To act on a system, click on the entry in the “Action” column.

To switch to the previous/next page click over the flipped page corners at the bottom of the
report.

Figure 5: The Maintenance Report window
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Kneeboard

The software come with a complete kneeboard window that contains the aircraft normal and
emergency checklists together with the performance reference tables.

Figure 6: The Kneeboard window
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Show the kneeboard using the plugins menu

The kneeboard window may be shown by clicking on the “Plugins” menu, then “SimCoders –
REP” then “Show kneeboard”.

Manage the kneeboard using the custom commands

You can also use five different custom commands at which you can assign your custom keys or
joystick buttons. The custom kneeboard commands defined by REP are the following:

Command Description

simcoders/rep/kneeboard/toggle Show or hide the kneeboard
simcoders/rep/kneeboard/next_section Show the next kneeboard section
simcoders/rep/kneeboard/prev_section Show the previous kneeboard section
simcoders/rep/kneeboard/next_page Show the next kneeboard page
simcoders/rep/kneeboard/prev_page Show the previous kneeboard page
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Mass & Balance

The Reality Expansion Pack provides a Mass & Balance tool to precisely load the plane.

While loading the plane, the goal is to keep the crosses inside the plot section delimited by the
blue area, like shown in the screenshot below.

Figure 7: The Mass & Balance window

The blue area is the Center of Gravity Envelope. The mass is reported on the Y axis, the Center
of Gravity Arm is reported on the X axis.

If the cross is towards the left side of the plot, it means that the center of gravity will be towards
the front of the airplane, that is, the airplane will be nose heavy.

On the other hand, if the cross is on the right side of the plot, the airplane will be tail heavy.

If you overload the airplane and the cross goes outside the blue envelope, the cross becomes
red, indicating that the plane is not allowed to fly.

Clicking on the “Apply” button, the selected passengers mass and fuel load will be applied to
X-Plane.

The unit of measure for the airplane mass and the C.G. arm can be changed by clicking the
“Change Units” button.
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Walkaround

Click on the Walkaround icon in the lateral menu to enter walkaround mode. Click again on the
same icon on close the walkaround window to return in the cockpit.

During walkaround you can interact with some external systems of the aircraft using the walka-
round window. Click the “Next” and “Prev” buttons at the bottom of the pre-flight checklists to
move along the different pre-flight stations.

Always do the walkaround and the pre-flight inspection before each flight.

If you do not remove the tie-down and the chocks, you are not able to taxi and takeoff properly.

If you do not remove the pitot cover, you will incur an airspeed indicator failure.

Since version 3.4.5, it is possible to toggle all the static elements - such as the pitot cover and
the tiedowns - using a single entry in the plugins menu or a keyboard command.

Since version 3.3, the following keyboard/joystick commands are available to control the walka-
round mode.

Command Description

simcoders/rep/walkaround/toggle Toggle the walkaround mode
simcoders/rep/walkaround/next Next walkaround station
simcoders/rep/walkaround/previous Previous walkaround station
simcoders/rep/walkaround/action Execute current action
simcoders/rep/walkaround/static_elements/toggle Static elements toggle

Move the viewpoint while doing the walkaround in 2D

It is possible to move the viewpoint during towing by using the default camera commands of X-
Plane. To pan the view using themouse, keep pressed the simcoders/rep/view/pan_with_mouse
command.

Walkaround in VR

REP provides a series of hotspots around the airplane useful to check the plane during the
pre-flight, post-flight and lights-check checklists.

Start the walkaround using the simcoders/rep/walkaround/toggle command and then move
from station to station using your VR controller. Make sure you bring the walkaround window
with you while moving from a station to another.

Towing

REP comes with a complete towing simulation. To activate it, click on the towing icon in the
lateral menu. Click the icon again to exit from the towing mode.

The towing features a 3D towing bar that will help you driving the airplane on the tarmac.

To move the airplane, push or pull the pitch axis of your joystick. Use the roll axis to turn.
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Since REP simulate the force applied by a single man placed in front of the airplane, you may not
be able to tow the airplane on the grass, just like in real life.

You won’t be able to tow the airplane if it’s tied-down or if chocks/brakes are applied.

Move the viewpoint while towing in 2D

It is possible to move the viewpoint during towing by using the default camera commands of X-
Plane. To pan the view using themouse, keep pressed the simcoders/rep/view/pan_with_mouse
command.

Towing in VR

REP provides an hotspot in front of the airplane (tricycle gear) or close to the tail (taildragger)
useful to drive the airplane in VR mode.

Toggle the towing mode using the simcoders/rep/towing/toggle command and then move the
airplane using your joystick as described above.

Engine Autostart

The Reality Expansion Pack provides you a way to automatically start the engines.

Click on the engine autostart icon in the side menu and wait until the startup procedure is
completed.

During the automatic start, REP shows a series of tips that describe the action being done.
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Settings Window

The settings windows is shown by clicking over the “Plugins -> SimCoders - REP -> Settings”
menu.

Enable the plane damages

When ticked, this option enable the plane damages.

Show generic messages

If ticked, REP will show generic messages related to systems status, when available.

Show failure messages

If ticked, REP will show a message in case of a system failure. The message will explain why the
failure happened and what course of action should be taken.

Show tip messages

If ticked, REP will show a tip message. The message will give some hints related to the current
pilot actions.

Show side menu on mouse hover only

When ticked, REP will completely hide the lateral menu when the mouse pointer leaves it.

Save and restore the plane status between sessions

If ticked, REP will save the airplane status when unloaded. When the same plane and livery are
loaded again, the status will be restored.

The status includes all the switches position, the fuel on-board, the loaded weights, the engine
fluids quantity and quality and all the possible values that play part to the systems simulation.

The engine temperatures - such CHT and Oil Temperature - are restored accordingly to the
elapsed time since the values where stored.

The status files are backed up before being overwritten. You find the backup in the
output/preferences/REP folder.

Save and restore the windows position between sessions

If checked, the Maintenance Hangar and the Keyboard windows positions are saved and restored
between sessions.

Enable hypoxia effect

When ticked, the default hypoxia effect is replaced by REP’s custom algorithm. See the Hypoxia
chapter to get more information about the custom hypoxia effect.
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Roll axis drives ground steering

When ticked, the joystick roll axis will steer the nosewheel on the ground.

Use US Customary

When ticked, REP will use the US Customary units of measure (pounds and inches).

Wind sound level

Control cabin the wind sound setting the level between 0 (mute) and 100 (full).

Main Monitor Index

This option is visible only if X-Plane is running on two or more fullscreen monitors. Type the
index of the monitor over which REP must show its menus and windows. The minimum number
you can set here is 1. The maximum number is your monitors count. Each number addresses a
different monitor.

Enable ITT Limiter

When ticked, REP will automatically limit the ITT to 800°C to avoid engine damages.

Use Advanced Steering

Enable this option to use REP’s advanced steering algorithm. You may need to disable this option
if you have issues with steering with your hardware pedals.

Use Advanced Braking

Enable this option to smooth the brakes and to enable the automatic differential brakes. Instead
of applying the brakes all at once, they will go from 0 to 1 in two seconds, smoothing the braking
action. Automatic differential braking is applied if brakes are pressed while steering. Disable
this option if you use hardware toepedals.

Use VR Walkaround and Towing

When enabled, this option allows to use the new VR walkaround and towing modes.

Wait for real weather at startup

When this options is enabled together with the simulator real weather, REP waits for the real
weather to be correctly loaded before loading the plane status and update the systems’ tempera-
tures. This option is not needed in X-Plane 12 therefore it is not shown.

In flight tips vertical offset

Set the vertical offset of the in-flight window. By default, the tips are shown at the top of the
main screen.
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ECONOMY SYSTEM

The Reality Expansion Pack features a custom Economy System that may rewards you for your
flight time and lets you pay to fix the airplane damages and do the everyday maintenance.

The Economy System features two modes of operation:

• Standalone: your bank account and maintenance records are locally saved to your PC.
They are shared among your REPs. The system rewards you for your flight time and landing
skills.

• FSEconomy: REP connects to the FSEconomybank account and drains the required amount
of money for maintenance directly from there. There are no rewards for your flight time as
they are already provided by FSEconomy.

• X-CPL-Pilot: REP connects to the X-CPL-Pilot bank account from which it drains the
required amount of money for maintenance. There are no rewards for your flight time
because they are paid by X-CPL-Pilot already.

Enable the Economy System

Open the Maintenance Report window then scroll to the latest page available. Click on the
“Enable” button corresponding to the economy system you want to enable.

When enabling the FSEconomy System, it is required to enter an Aircraft Key.

The Aircraft Key is a 15 chars key provided by FSEconomy that uniquely identifies the aircraft
you are flying in the FSEconomy environment.

To find the Aircraft Key:

1. Login to the FSEconomy website: http://server.fseconomy.net/
2. Click the main menu’s “Aircraft” button
3. Scroll the aircrafts’ list down to the plane you want to connect to REP
4. In the “Action” column, click the drop-down menu’s “Edit” button
5. Generate/Copy the Aircraft Key in the webpage’s lower-left corner

When the Economy System is enabled, the aircraft state is saved to a separated file. When you
disable the Economy System, that very same file is loaded again.

Thus, there are two different aircraft states that are loaded in relation to the usage of the Economy
System. One state is loaded and updated when the Economy System is disabled. The other one
is loaded and updated when the Economy System is enabled.

You can switch between the two states by disabling or enabling the Economy System.

The Bank Account is shared among all your REP airplanes. That is, it possible to earn money
flying an airplane and use it to fix another airplane that needed maintenance.

How it works

Once enabled, the Economic System page in the Maintenance Report shows your current Bank
Account Balance and a log of the last transactions (amount spent for maintenance and fuel or
income from a flight).
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Figure 8: This is the screen that allows you to enable the Economy System

©SimCoders.com - For flight simulation only. Do not use for real flight Page 19



Reality Expansion Pack
Pilatus PC-12 How it works

Figure 9: This is the default screen of the Economic System
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Each fix or maintenance you want to do to your airplane must be first added to a quotation.

Each page of the Maintenance Report shows a table that reports the available maintenance
actions.

For each action, the table reports the price and required work time.

To add a maintenance action to the Quotation, click over its “Action” cell in the Maintenance
Report. Once an action has been added to the Quotation, the “Action” cell reports “In Quote”. To
remove the maintenance action from the Quotation, click the “Action” cell again.

If the “Action” column is empty, it means that no actions are available at that time.

Once all the needed maintenance actions have been added to the Quotation, click over “View
Quotation” or scroll to the last page of the Maintenance Report to see the Quotation.

The quotation reports two possible total prices:

• Normal Price: This price will be applied for a fix that will take the amount of time reported
in the time column. The fixes will be done one at a time in real time. The mechanic will
continue his work even when the sim is closed.

• Quick Fix Price: This price will be higher but will do all the actions at once in zero time.

You can accept either price or decline the Quotation, in which case no action is done and the
quotation is scrapped.

Buy/Sell Fuel

This feature is available in Standalone Mode only.

In the Weight and Balance window, it is possible to add/remove fuel from the fuel tanks.

Adding fuel will drain money from your bank account. Removing fuel from the tanks will result in
selling it to the local airport. The selling price will be slightly lower than the local buying price.

Fuel price is based on the current country/region and varies from airport to airport and from
time to time. It is possible to specify a custom fuel price in the “fuel_prices.cfg” file found
in the “Output/preferences/REP” folder of X-Plane. The file already contains an example of
a custom price for two airports. Once REP calculates a fuel price, it stores is for a random
interval between 4 and 8 days, then it recalculates the fuel price again. That is, when you set
a new fuel price in the fuel_prices.cfg file, REP will not use it immediately. Instead, it will start
using it the next time it will need to recalculate the fuel price for that airport.

It is possible to check the fuel price in a specific airport by going to the plugins menu and click
over “SimCoders - REP” -> “Check fuel price at an airport”.

Earn Money: Rewards

This feature is available in Standalone Mode only.

The more you fly, the more money you earn. At the end of a flight, a new Log entry is added to
your Bank Account Log with the amount of money you earned.

In case you make a smooth landing, a “Soft Landing” bonus is added to your reward. The softer
the landing, the higher the reward.
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Figure 10: Click over one of the Action cells to put that specific action in the quotation. Note:
The maintenance report shown here is an example of how the table looks. It may not include the
systems modeled in the airplane described in this manual.
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Figure 11: A Quotation Example
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VR Support

REP supports the native VR implementation since version 3.4.0. VR support was further improved
in version 4.5.0.

How to open the plugin windows in VR

REP provides a set of commands to control the plugin windows.

• simcoders/rep/vr/open_menu: open REP’s main menu
• simcoders/rep/fuelmenu/show: show the fuel menu when using the economy system
• simcoders/rep/maintenancereport/show: show the maintenance report
• simcoders/rep/settingsmenu/show: show the settings menu
• simcoders/rep/weightandbalance/show: show the weight and balance (if supported)
• simcoders/rep/towing/toggle: toggle the tow mode
• simcoders/rep/kneeboard/toggle: toggle the kneeboard
• simcoders/rep/walkaround/toggle: toggle the walkaround mode

For more information about how to assign the commands above please read X-Plane’s user
guide about assigning commands to buttons.

NOTE

Make sure you loaded a REP airplane before looking for the command in X-Plane’s settings
window.
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Figure 12: The Tech Report shown in VR mode

SOUNDS SYSTEM

The Reality Expansion Pack features a custom sound system that provides immersive 3D sounds
throughout the entire flight experience.

A custom sounds system has been preferred over the usage of FMOD for the following reasons:

• FMOD could be rather cumbersome from the developer’s point of view, requiring more time
to produce new features

• A custom engine is more flexible and can be expanded in no time providing new features
• A custom engine is more efficient as it’s taylored to our needs

REP’s sounds system provides advanced sounds such:

• Engine ignition
• Engine pings
• Engine exhaust effects
• Fuel pumps
• Electric Gyros
• Avionics effects
• Dynamic touch down
• Dynamic ground roll
• Dynamic wind
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PERSISTENT AIRCRAFT AND COMPONENTS WEARING

The Reality Expansion Pack features a complete wearing system for the entire airplane. That is,
each component of the airplane wears out when in use and, after a certain amount of time, it
may start to show some issues or fail completely.

The status of each component is saved and updated even if the sim is not running.

This is true for things such as engine components, electrical system parts, airframe, and landing
gear.

Every component will be affected by time and by user’s handling in different ways.

If you mistreat the engine by running it above its limits, it will get worn out, showing startup
issues, combustion problems and providing less power than expected. It will completely fail
over time.

The cockpit instrumentation needles will be more precise in a newly calibrated gauge rather than
in an old one.

How to load a worn out aircraft

REP gives you the chance to load an aircraft that is already worn out by its past history.

To do so, go to “Plugins -> SimCorders.com - REP -> Wear out to >” and choose one of the
following items.

• Brand New: this is the status of an aircraft that just left the production line. The engine is
brand new and all the onboard systems were just tested.

• Privately Owned (new): this is an almost new aircraft that has been privately owned with
care. The engine as well as the other systems will have some hours logged but no issues
are in place.

• Privately Owned (old): this is an aircraft that has been owned privately for years. The
engine as well as the other systems will have many hours logged but no issues are in place
as the private owner kept the plane with good care.

• Flying Club: this plane has been in the hands of many pilots, some of them careless. The
systems are weared out quite much and some gauges are not working as good as you
would like them to do.

How to check the components status

To check each component and fix/replace/calibrate it, use the Maintenance Report.

In there are listed all the aircraft components that can be checked by a mechanic.

Hobbs Time and Tach Time

In the Maintenance Report you find the airframe total time (Hobbs Time) and the engine’s total
time (Tach Time). The two value may slightly differ after loading a brand new airplane and then
flying it for a while. This is because there’s an important difference in how the two times are
calculated.
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Hobbs Time

In most planes, the Hobbs clock is started and stopped based on an oil pressure switch, so it
starts when the engine starts, and stops when the engine is shut-down. While it’s running, it just
ticks off a tenth of an hour every 6 minutes, based on “regular wall clock time”. So a tenth of
idling on the ramp is the same as a tenth at cruise.

Tach Time

The tach clock isn’t really a clock at all, it doesn’t actually measure time, it really measures engine
revolutions. But it’s calibrated such that a tenth of an hour of tach time is clicked off when the
engine is at cruise RPM for 6 minutes. In other words, if the plane is at cruise RPM, the tach
clock will be clicking off tenths of an hour at the same rate as the Hobbs clock. But if the engine
is idling at an RPM speed that’s half of what cruise RPM is, then the tach clock will be running at
half the speed of the Hobbs clock.
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SYSTEMS DESCRIPTION

Within the Reality Expansion Pack, each system has its own life-cycle and can be damanged
depending on many factors, including the pilot’s behavior.

All systems can be fixed individually using the Maintenance Report or all at once using the
simcoders/rep/systems/fix_all command.

The following is a brief description of each system onboard.

Powerplant

This airplane is powered by the Pratt & Whitney PT6A-67B, which is a light weight, reverse flow,
free turbine engine. In addition to the gas generator section, the PT6A-67B incorporates a power
section with the power turbine and propeller reduction gearbox, an integral oil system, and an
accessory gearbox for mountings for various accessories.

Air enters the compressor through an annular plenum chamber. The compressor consists of four
axial stages and a single centrifugal stage. Stator vanes between each stage of compression
diffuse the air, raise its static pressure, and direct it to the next stage of compression. From the
centrifugal compressor, air flows through a diffuser tube, then changes direction 180 degrees as
it flows into the combustion chamber. A compressor bleed valve is installed on the gas generator
case at the 3 o’clock position. It automatically opens to spill interstage compressor air to prevent
compressor stall.

The combustion chamber consists of two perforated annular sections bolted together with a
large exit duct. Compressed air enters the combustion chamber through the perforations, where
it is mixed with fuel and ignited. The rapidly expanding gas is directed through another 180
degree direction change into the turbine.

The turbine consists of a single stage compressor turbine and a two-stage power turbine. As the
gas exits the combustion chamber, it is directed onto the compressor turbine, which powers the
compressor. From the compressor turbine, the gas is directed to the two-stage power turbine
which drives the propeller via the propeller reduction gearbox. Engine inter turbine temperature
(ITT) is measured between the compressor and power turbines.

Gas flow is directed into the exhaust duct from the turbine. The exhaust duct has an annular
inlet which leads exhaust gas to a bifurcated duct connected to two opposed exhaust ports. The
exhaust duct is made from heat resistant nickel alloy metal and incorporates mounting flanges
for the exhaust nozzles.

Throttle System

Power Control Lever (PCL)

The POWER CONTROL lever (PCL) selects the required engine power (Ng) and in certain condi-
tions it directly controls the propeller pitch. The PCL has a flight and a ground operating range
separated by an idle detent. The flight operating range is forward of the detent. As the PCL is
moved forward of the idle detent the minimum propeller pitch (6° to 12°) is directly controlled
by the PCL while the propeller is in an underspeed condition during low engine power at a low
airplane speed. When the PCL is moved further forward, engine power and airplane speed
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increase until each are high enough for the propeller to operate in a constant speed mode. In this
mode, the Constant Speed Unit (CSU) selects the propeller pitch to maintain a propeller speed
of 1700 rpm.

When the PCL is at the idle detent, the gas generator is at idle and the propeller is at minimum
pitch. A lifting action to raise the PCL over the detent is required to move the PCL into the ground
operating range.

Aft of the idle detent is the ground operating range or beta mode. The Nf governor limits the
propeller speed to an underspeed condition to give the beta valve full authority in controlling the
propeller pitch. The engine power and propeller pitch are directly controlled by the PCL. Initial
PCL movement aft of the idle detent adjusts the propeller pitch while the gas generator remains
at idle and can be used to control taxi speed. Further aft movement causes the propeller to move
into the reverse range followed by an increase in engine power.

Aft of the idle detent is the ground operating range or beta mode. The Nf governor limits the
propeller speed to an underspeed condition to give the beta valve full authority in controlling the
propeller pitch. The engine power and propeller pitch are directly controlled by the PCL. Initial
PCL movement aft of the idle detent adjusts the propeller pitch while the gas generator remains
at idle and can be used to control taxi speed. Further aft movement causes the propeller to move
into the reverse range followed by an increase in engine power.

Manual Override Lever (MOR)

The MANUAL OVERRIDE lever (MOR) is located on the center console to the left of PCL. The
MOR controls the engine power in case of a pneumatic failure of the engine fuel control or in
case of a PCL system failure. The MOR lever is an emergency device and it is possible to exceed
engine limits if the MOR lever is operated too fast. However, even if the engine limits have been
momentarily exceeded, the MOR will allow the crew to continue safe flight and landing if the
Engine Failure in Flight - Partial Power Loss emergency procedure is followed.

The MOR directly operates the fuel metering valve by mechanically compressing the pneumatic
bellows (Py pressure) in the FCU. There is a gap between theMORmechanism and the pneumatic
bellows. This gap must first be taken up before the pneumatic bellows start to compress, this
results in a dead band when starting to operate the MOR lever. In case of a Py leak, the engine
spools down to minimum fuel flow with no response to PCL inputs. Minimum fuel flow is 90
lb/h and results in 35% Ng on the ground to 70% Ng at 30,000 ft. The higher the altitude and the
faster the forward speed the longer the engine spool down time to 50% (spool down times of 15
secs are possible). At high altitudes it is possible to achieve full engine power when operating
the MOR system. At low altitudes with the MOR lever fully forward the MOR system may not give
full engine power (min. 30 psi torque). When the MOR system is in operation the torque limiter
and Ng governor are inoperative.

Operation

During normal engine operation the MOR lever is in the full aft or OFF position. In the case of a
possible PCL or pneumatic failure, the PCL should be exercised to check engine response. If not
successful the PCL should be set to the idle position and the MOR lever operated slowly forward
(at least 4 secs to the mid position) to take up the dead band until the engine responds (fuel flow
above 90 lb/h and Ng/ITT stable or increasing), then wait until the engine stabilizes. If the engine
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stalls and/or ITT reaches 870° C, operate the MOR lever slightly rearward then forward again with
an even slower movement. If the engine is allowed to drop below 50% Ng, starter assistance
may be required to recover Ng above 50%. Once the engine has stabilized adjust the required
power setting with the MOR lever. Observe the engine limitations by making adjustments with
the MOR lever. Do not permit the Ng to fall below 65% as ITT may then be exceeded, this will
also maintain better engine acceleration. In descent and until touch down adjust Ng to 75% or
above. After touch down select cut-off feather to avoid exceeding ITT limits. On the ground with
no forward speed it is not possible to recover low Ng with the MOR lever.

Condition Lever

The Condition Lever has three positions and is used to select the gas generator idle speed,
shut down the engine, and feather the propeller. The GROUND IDLE position (G.I.) is for ground
operation only. This setting ensures that the propeller speed remains above the prohibited range
(350 rpm to 950 rpm) for ambient conditions up to a temperature of approximately 45°C. The
FLIGHT IDLE position (F.I.) is selected for flight operation which provides sufficient bleed air
flow to maintain cabin pressurization at minimum Ng and to give smooth engine response to
PCL movement during approach and landing. The CUT-OFF/FEATHER position mechanically
stops the fuel flow to shut down the engine and energizes the overspeed governor solenoid
valve, which feathers the propeller at the same time. The low fuel pressure switch is inoperative
when the Condition Lever is in the CUT-OFF/FEATHER position.

Engine Care Tips

Avoid a Hot Start

If the ITT goes above the 800°C limitation during engine start, the engine may be seriously
damaged and we call it a Hot Start.

To prevent this from happening be sure to:

• Do not introduce fuel until Ng is above 12% (better over 13%)
• Do not move the condition lever from cutoff to flight idle until the engine has stabilized
unless the OAT is below 5°C

• Do not introduce fuel if the ITT is above 40°C)
• Do not attempt an engine start if the battery voltage is below 25V. Use external power is
available.

• Since the condition lever manipulator is really sensible to mouse movements, it’s highly
recommended to use keyboard commands or joystick to control it
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Electrical Systems & Avionics

The airplane is equipped with a 28-volt, direct-current electrical system.

The system uses a battery as the source of electrical energy. An alternator maintains its state of
charge.

Battery

The default battery is replaced with a battery that keeps its charge between sim sessions and
discharges at a realistic rate. The battery state is updated even when the simulator is not running.
This means that if you leave your battery on, it will discharge even if X-Plane is closed.

In the “Electrical System & Avionics Status” page of the Maintenance Report you can:

• Check the battery charge
• Recharge the battery
• Disconnect the battery poles from the electrical system

If you plan not to fly the airplane for awhile, you should disconnect the battery via theMaintenance
Window. This will avoid self-discharging and extend the battery life during storage.

Alternator

The alternator switch position is saved through all X-Plane sessions. Make sure it is switched in
the correct position according to the checklists throughout the entire flight.

The alternator switch operation may affect the avionics. Check the Avionics paragraph below to
get more information.

Lights

The light switch positions are saved through all X-Plane sessions.

If the airplane is not provided with strobe lights fmod sounds, the Reality Expansion Pack adds
the strobe lights sounds when the lights are switched on.

Electrical Gyros

The Reality Expansion Pack replaces the default X-Plane electrical gyros with custom ones with
a more realistic spin up/down dynamics.

The typical spin up/down sounds are reproduced when the battery switch is turned in the “On”
position. The instruments provided with an electrical gyro and therefore depending on the
electrical supply are the turn/slip indicator, the standby attitude indicator and the HSI, if they are
provided.

Radio Stack

The radio components save their own state - such as frequencies and knobs position - during
X-Plane sessions.
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In the “Electrical System & Avionics Status” page of the Maintenance Report you can:

• Check the status of each radio
• Fix a faulty radio

CAUTION

Never turn on or off the engine or the alternator when the avionics switch is in the “On” position.
Doing so may trigger a overvoltage spike that could damage one or more avionics components.

The newer avionics such as the Garmin GNS430/530 are better protected from overloads but
they are not totally immune from them.

Landing Gear

The airplane is equipped with a tricycle, hydraulically actuated, retractable landing gear. When in
good shape, the landing gear requires from 6 to 8 seconds to fully extend or retract.

The Reality Expansion Pack introduces the following changes to the default landing gear:

• Improved ground roll physics: REP corrects the default behavior of X-Plane on ground in
cross wind conditions, when the airplane tended to steer against the wind.

• Custom touchdown sounds: The touchdown sounds tone and volume are related to the
touchdown speed. A harder touchdown will produce different sounds than a soft landing.

• Brakes sounds: Actuating the brakes produces the typical whining sound. Also the classic
squeaking sounds are reproduced when the brakes are not in perfect shape.

In the “Landing Gear & Brakes Status” page of the Maintenance Report you can:

• Check the status of the landing gear struts
• Fix a faulty strut

Tires

The Reality Expansion Pack simulates the tire status and failure based on the landings done in
the past.

A flat tire can cause the plane to yaw during the landing run or get it stuck on the ground before
taxi.

In the “Landing Gear & Brakes Status” page of the Maintenance Report you can:

• Check the status of each tire
• Fix a faulty tire

Brakes

The PC-12 has a single-disc, hydraulically-actuated brake on each main landing gear wheel. Each
brake is hydraulically connected to a cylinder attached to each of the pilot’s rudder pedals.
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The brakes are operated by applying pressure to the top of the rudder pedals, which are intercon-
nected. When the airplane is parked the brakes may be activated using the parking brake switch
located under the pilot’s yoke.

To avoid brake failures, keep the brake system properly maintained and minimize brake usage
during taxi operations and landings.

Do not apply the brakes for a long time. If the runway is long, let the plane slow down by itself.

In the “Landing Gear & Brakes Status” page of the Maintenance Report you can:

• Check the status of the braking system
• Fix a faulty brake
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Oxygen System

The PC-12 is a pressurized plane and an emergency oxygen system is then provided.

The oxygen system is operated using the View -> Oxygen Mask X-Plane command.

The oxygen flow pressure varies with the oxygen tank pressure. It lasts about 25 minutes.

In the “Oxygen System Status” page of the Maintenance Report you can:

• Check the quantity of oxygen in the tank
• Refill the oxygen tank
• Calculate how long will the oxygen last based on the number of people on-board

©SimCoders.com - For flight simulation only. Do not use for real flight Page 34



Reality Expansion Pack
Pilatus PC-12

HUMAN FACTOR

Hypoxia

Hypoxia is a condition in which the body or a region of the body is deprived of adequate oxygen
supply at the tissue level.

As altitude is gained, the partial pressure of Oxygen gets lower and lower to the point that the
human body is unable to absorb enough quantity of it to sustain life.

The symptoms of hypoxia are:

• Apparent personality change
• Impaired judgement
• Headache
• Tingling
• Increased rate of breathing
• Muscular impairment
• Memory impairment
• Visual sensory loss
• Tunnel vision
• Impairment of consciousness
• Cyanosis
• Unconsciousness
• Death

The Reality Expansion Pack simulates some of the symptoms above, such as the tunnel vision,
the increased rate of breathing and the muscular impairment.

TUC & EPT

Time of Useful Consciousness (TUC) is the time available for the development of hypoxia and
the pilot to do something about it. It is not the time to unconsciousness but the short time from
a reduction in adeguate oxygen until a specific degree of impairment, generally taken to be the
point when the individual can no longer take steps to help him/herself.

Effective Performance Time (EPT) is always within and shorter than TUC. Its quantification
however depends on the individual.
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The following is a table that represent the EPT simulated by REP.

Altitude (ft) EPT

10000 Few hours
15000 40 minutes
20000 10 minutes
30000 30 seconds
40000 15 seconds
45000 1-2 seconds

Figure 13: Hypoxia effect
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HOME COCKPITS/CUSTOM DATAREFS

In order to work properly, REP uses a set of custom datarefs instead of default X-Plane ones.

Here you find a list of datarefs that you can use for your home cockpit.

This list includes all REP’s datarefs. Some of them might not be present on some REP, depending
on the systems depicted by the package.

Dataref: simcoders/rep/stallwarning/on

• Type: int
• Writable: No
• Contents: 0 = off, 1 = on

Dataref: simcoders/rep/stallwarning/level

• Type: int
• Writable: No
• Contents: 1 = low, 2 = high

Dataref: simcoders/rep/cockpit2/gauges/indicators/vacuum

• Type: float
• Writable: No
• Contents: Vacuum gauge value

Dataref: simcoders/rep/cockpit2/gauges/indicators/attitude_indicator_0_pitch

• Type: float
• Writable: No
• Contents: Main attitude indicator pitch

Dataref: simcoders/rep/cockpit2/gauges/indicators/attitude_indicator_0_roll

• Type: float
• Writable: No
• Contents: Main attitude indicator roll

Dataref: simcoders/rep/cockpit2/gauges/indicators/attitude_indicator_1_pitch

• Type: float
• Writable: No
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• Contents: Stdby attitude indicator pitch

Dataref: simcoders/rep/cockpit2/gauges/indicators/attitude_indicator_1_roll

• Type: float
• Writable: No
• Contents: Stdby attitude indicator roll

Dataref: simcoders/rep/cockpit2/gauges/indicators/airspeed_kts_pilot

• Type: float
• Writable: No
• Contents: Pilot airspeed

Dataref: simcoders/rep/cockpit2/gauges/indicators/airspeed_kts_copilot

• Type: float
• Writable: No
• Contents: Copilot airspeed

Dataref: simcoders/rep/cockpit2/gauges/indicators/altitude_ft_pilot

• Type: float
• Writable: No
• Contents: Pilot altitude

Dataref: simcoders/rep/cockpit2/gauges/indicators/altitude_ft_copilot

• Type: float
• Writable: No
• Contents: Copilot altitude

Dataref: simcoders/rep/cockpit2/gauges/indicators/vvi_fpm_pilot

• Type: float
• Writable: No
• Contents: Pilot VSI

Dataref: simcoders/rep/cockpit2/gauges/indicators/vvi_fpm_copilot

• Type: float
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• Writable: No
• Contents: Copilot VSI

Dataref: simcoders/rep/cockpit2/switches/avionics_power_on

• Type: int
• Writable: Yes
• Contents: Avionics switch

Dataref: simcoders/rep/indicators/fuel/fuel_quantity_0

• Type: float
• Writable: No
• Contents: Fuel kg in tank 0

Dataref: simcoders/rep/indicators/fuel/fuel_quantity_ratio_0

• Type: float (ratio 0..1)
• Writable: No
• Contents: Fuel ratio in tank 0

Dataref: simcoders/rep/indicators/fuel/fuel_quantity_1

• Type: float
• Writable: No
• Contents: Fuel kg in tank 1

Dataref: simcoders/rep/indicators/fuel/fuel_quantity_ratio_1

• Type: float (ratio 0..1)
• Writable: No
• Contents: Fuel ratio in tank 1

Dataref: simcoders/rep/indicators/fuel/fuel_quantity_2

• Type: float
• Writable: No
• Contents: Fuel kg in tank 2

Dataref: simcoders/rep/indicators/fuel/fuel_quantity_ratio_2
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• Type: float (ratio 0..1)
• Writable: No
• Contents: Fuel ratio in tank 2

Dataref: simcoders/rep/indicators/fuel/fuel_quantity_3

• Type: float
• Writable: No
• Contents: Fuel kg in tank 3

Dataref: simcoders/rep/indicators/fuel/fuel_quantity_ratio_3

• Type: float (ratio 0..1)
• Writable: No
• Contents: Fuel ratio in tank 3

Dataref: simcoders/rep/engine/fuelline/electrical_feed_0/switch_on

• Type: int
• Writable: Yes
• Contents: L tip pump switch (1 = on)

Dataref: simcoders/rep/engine/fuelline/electrical_feed_1/switch_on

• Type: int
• Writable: Yes
• Contents: R tip pump switch (1 = on)

Dataref: simcoders/rep/indicators/fuel/fuel_flow_0

• Type: float
• Writable: No
• Contents: L FF indicator

Dataref: simcoders/rep/indicators/fuel/fuel_flow_1

• Type: float
• Writable: No
• Contents: R FF indicator

Dataref: simcoders/rep/cockpit2/gauges/indicators/engine_0_rpm
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• Type: float
• Writable: No
• Contents: L RPM indicator

Dataref: simcoders/rep/cockpit2/gauges/indicators/engine_1_rpm

• Type: float
• Writable: No
• Contents: R RPM indicator

Dataref: simcoders/rep/cockpit2/engine/actuators/fuel_pump_0

• Type: int
• Writable: Yes
• Contents: L pump (0 = off, 1 = on)

Dataref: simcoders/rep/cockpit2/engine/actuators/fuel_pump_1

• Type: int
• Writable: Yes
• Contents: R pump (0 = off, 1 = on)

Dataref: simcoders/rep/cockpit2/engine/actuators/low_fuel_pump_0

• Type: int
• Writable: Yes
• Contents: L LO speed pump

Dataref: simcoders/rep/cockpit2/engine/actuators/low_fuel_pump_1

• Type: int
• Writable: Yes
• Contents: R LO speed pump

Dataref: simcoders/rep/cockpit2/engine/actuators/high_fuel_pump_0

• Type: int
• Writable: Yes
• Contents: L HI speed pump

Dataref: simcoders/rep/cockpit2/engine/actuators/high_fuel_pump_1
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• Type: int
• Writable: Yes
• Contents: R HI speed pump

Dataref: simcoders/rep/engine/electrical_fuelpump/switch_on_0

• Type: int
• Writable: Yes
• Contents: L pump (0 off, 1 LO, 2 HI)

Dataref: simcoders/rep/engine/electrical_fuelpump/switch_on_1

• Type: int
• Writable: Yes
• Contents: R pump (0 off, 1 LO, 2 HI)

Dataref: simcoders/rep/engine/cowl/handle_ratio_0

• Type: float (ratio 0..1)
• Writable: Yes
• Contents: L cowl flaps handle

Dataref: simcoders/rep/engine/cowl/handle_ratio_1

• Type: float (ratio 0..1)
• Writable: Yes
• Contents: R cowl flaps handle

Dataref: simcoders/rep/engine/oil/temp_f_0

• Type: float
• Writable: No
• Contents: L oil temp (F)

Dataref: simcoders/rep/engine/oil/temp_f_1

• Type: float
• Writable: No
• Contents: R oil temp (F)

Dataref: simcoders/rep/engine/oil/temp_c_0
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• Type: float
• Writable: No
• Contents: L oil temp (C)

Dataref: simcoders/rep/engine/oil/temp_c_1

• Type: float
• Writable: No
• Contents: R oil temp (C)

Dataref: simcoders/rep/engine/oil/press_psi_0

• Type: float
• Writable: No
• Contents: L oil press (PSI)

Dataref: simcoders/rep/engine/oil/press_psi_1

• Type: float
• Writable: No
• Contents: R oil press (PSI)
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RESOURCES & HOW-TOs

SimCoders.com blog contains tons of resources that you will find very useful when using REP.

Moreover, this is a list of How-Tos available.

• How to lean the mixture
• How to keep the spark plugs clean
• How to choose the right oil for your engine
• How to quickly startup the engine with REP
• How to manage an emergency
• How to calculate the required fuel for your flight

SUPPORT & CONTACTS

Before asking for support please read the FAQs we published on our site. They contain informa-
tion about installation troubles and general usage.

If you encounter any kind of technical problem with our software, please write to support@
simcoders.com providing as much information as possible and including your X-Plane’s Log.txt
file.
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VERSION CHANGELOG

V4.8.4

1. Fix: the Settings menu was not managed properly in VR

V4.8.3

1. No changes for this airplane.

V4.8.2

1. Fix: the system time was not always read correctly, therefore some features (like the
time-based maintenance actions may not always work propely on some systems)

V4.8.1

1. Fix: engine vibrations at startup were not visible anymore

V4.8.0

1. Support for time and ground speed multiplier

V4.7.14

1. No change for this airplane

V4.7.13

1. No change for this airplane

V4.7.12

V4.7.11

1. Improvement: the tie downs should better lock the plane to the ground

V4.7.10

Fix: after loading a saved flight, the alternator may not work properly

V4.7.9

1. Fix: in some engine configuration and bus loads, the alternator could not charge the battery
completely
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V4.7.8

1. Fix: In X-Plane 12 the plugin forces could bump the plane at engines stop
2. Fix: memory leak in datarefs handling

V4.7.7

V4.7.6

1. Fix: some sounds would not stop playing after plane crash
2. Fix: fuel totalizer fix in XP12

V4.7.5

No changes for this airplane

V4.7.4

No changes for this airplane

V4.7.3

1. Fix: Some components of the maintenance window were misplaced
2. Fix: Mass And Balance could not be applied correctly if the flight was started with the

engines running

V4.7.2

1. Fix: crash after replay

V4.7.1

1. Fix: crash after pause

V4.7.0

1. Improvement: better alternator voltage simulation at low RPM
2. Improvement: support for Apple M* processors
3. Improvement: better compatibility of the Mass and Balance system with X-Plane 12
4. Improvement: it is now possible to vertically move the in-flight tips windows (no VR support

for this feature at the moment)
5. Fix: missing library link if XP12

V4.6.6

1. Improved REP sound compatibility with internal X-Plane sound sliders
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V4.6.5-h2

1. Fixed broken plugin reset

V4.6.5-h1

1. Fixed broken dataref

V4.6.5

1. Improved OpenAL errors log
2. Improved braking system compatibility with hardware toe pedals
3. Improved static elements compatibility with third-parties addons

V4.6.4

1. No changes for this plane

V4.6.3

1. No changes for this plane

V4.6.2

1. Improvement: MAP behavior at low RPM

V4.6.1

1. Fix: the model name depicted in the maintenance report was incorrect
2. Fix: the serial number depicted in the maintenance report may be off

V4.6.0

1. Change: “Smooth Brakes” and “Automatic Differential Brakes” options merged into the
“Advanced Braking” option

2. New: REP now includes TXT format checklists too
3. Improvement: Experimental Flight Model Support
4. Improvement: more realistic elevator trim authority
5. Improvement: flaps extension time has been raised to 22s
6. Fix: Ng could not go higher than 100%
7. Improvement: better LOP cut-out behavior in piston engines
8. Improvement: more realistic piston engine power response when running ROP
9. Improvement: more realistic manifold pressure behavior at high RPM

10. Improvement: running oversquare when LOP does not damage the piston engines
11. Improvement: REP waits for the real weather to load (if enabled) before updating the engine

temperatures at startup
12. Improvement: improved hypoxia recover at low altitude
13. Fix: the manifold pressure was too low at idle
14. Fix: The REP update loop was not always executed correctly in certain configurations
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15. Fix: The avionics is less prone to damage if the alternator is turned on/off with the avionics
master on

V4.5.12

1. Improved towing behavior

2. Added engine cooling down sounds (exhaust ticks)

3. No changes for this plane

V4.5.10-h1

1. Fix: on Linux the plugin could crash the sim on startup because of a bad library link

V4.5.10

1. A cancel window is shown before beginning the engine autostart procedure
2. Fix: the instrument wear could not save its state properly on some systems
3. Fix: the propeller could go in overspeed under certain power conditions
4. The HSI map line is now disabled to match real world avionics behavior
5. TO/GA Pitch Up set to 7.5 degrees

V4.5.9

1. Improved the FSEconomy implementation reliability

V4.5.8

1. Improved the hardware rudder pedals compatibility (it is now possible to disable the
automatic differential braking)

V4.5.7

V4.5.6

1. New: REP Economy System now supports X-CPL-Pilot
2. Fix: in the maintenance window, some text could oveflow from the borders
3. Fix: in some configurations, the installer may not properly modify the FMOD .snd files

V4.5.5

1. The static elements are not visible anymore during replay
2. REP reports in X-Plane’s log when a damage/failure is taking place

V4.5.3

V4.5.2
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V4.5.1

1. Fix: the oil pump failure message was missing

V4.5.0

1. New: improved VR support in walkaround and towing modes
2. The magnetos are forced to “both” when starting the flight with engines running
3. The tiedowns and chocks are removed when starting the flight with engines running
4. It’s not possible to begin the autostart procedure if the engine is already running
5. Fix: CTD when trying to connect to FSE
6. Fix: Typos in Maintenance Window
7. Fix: excessive oil comsuption when a cylinder is partially worn out

V4.4.6

1. Fix: the O2 lever did not work as expected

V4.4.5

1. Fix: typo in final checklist
2. The in-flight tips window now resize correctly in VR
3. Optimizations for XP11.50
4. Some sounds (very few) were played using the wrong equalizers resulting in too high or

too low volume in relation to their position in the cockpit

V4.4.4

1. Fix: XP10 crash on reload
2. Fix: CTD on plugin disable
3. Fix: The Oxygen System did not support the Economy System properly
4. The Basic Empty Weight is raised to 6200lbs and the CG is moved aft accordingly to new

data obtained
5. Fix: engine total time reporting was incorrect

V4.4.3

1. New: dataref to control the wind volume: simcoders/rep/settings/wind_volume
2. Fix: in some cases the ITT was not restored properly from the previous session
3. Fix: memory leak

V4.4.2

1. New: the standalone fuel market support USA airport codes 3 chars long
2. Fix: large windows did not fit the screen properly
3. Fix: the PT-6 engine did not show failures using in-flight tips

V4.4.1
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V4.4.0

1. The simulator<->REP interface has been reworked to accommodate future improvements

V4.3.5

1. FSEconomy: fix for HTTPS protocolo update

V4.3.4

1. FSEconomy: fixed connection issue (HTTP 301 not followed properly)

V4.3.3

V4.3.2

1. Fix: the com radio status was not properly restored

V4.3.1

1. Added the option in the settings window to enable or disable the ITT limiter
2. New option to show or hide the generic messages
3. Improved the Nav/Com radios status feedback in the maintenance window
4. Fix: the maintenance window could crash during the FSEconomy data update

V4.3.0

1. Introduced the Pilot Emergency O2 System
2. Improved ITT evolution on plane loading (the ITT is restored from the previous flight, taking

into accout the elapsed time)
3. Improved the flaps flight dynamics behavior
4. Fix: the Economy System status could be loaded only partially in some situations
5. Fix: the in-flight tips were not visible in VR. Thanks to sparker for helping debugging the

issue.
6. Fix: walkaround CTD
7. Fix: message boxes did not support VR
8. Improved the engine negative torque model

V4.2.3

1. Fix: solved some windows positioning issues
2. Fix: in XP10 REP did not recognize opening a window as a paused sim state
3. Fix: the pressurization system broke too easily
4. Fix: the fuel color was wrong during ground checks
5. Fix: some engine components were not worn out using the “Wear to. . . ” menu option
6. The standalone economy system rewards were too low for this kind of aircraft
7. Improved checklists
8. The ECS Switch position is now saved and restored between session
9. Improved oil pressure behavior

©SimCoders.com - For flight simulation only. Do not use for real flight Page 50

https://forums.x-plane.org/index.php?/profile/73618-sparker/


Reality Expansion Pack
Pilatus PC-12

10. Improved battery behavior

V4.2.2

1. Fix: vr_config.txt error message at startup
2. Fix: the torque and ITT limiter is now smoother than before, letting engine parameters to

stabilize
3. Fix: the pressurization system did not track the usage time properly
4. Fix: the lights check UI did not set the landing lights switch properly
5. Fix: the “Reset Economy System” button did not fix part of the PT6 turbine components
6. Improved the condition lever behavior
7. Improved the ground roll sounds
8. Fix: the kneeboard andmaintenance windows did not save their position properly, therefore

they were not shown correctly after being popped out
9. Fix: and X-Plane 11.35 bug prevented REP from reading the proper airspeed

V4.2.1

1. No changes for this aircraft

V4.2.0

1. New: Simulation of Factory and Tuned exhaust effects
2. New: The status file are backed up before being overwrited
3. New: It is now possible to save the windows position between sessions
4. Improved manifold pressure behavior

V4.1.8

1. New: it is now possible to set the wind sound volume in REP’s settings window

V4.1.7

1. CTD fix

V4.1.6

1. Minor Networking fix

V4.1.5

1. Increased the debug log for the Economic System

V4.1.4

1. No changes for this aircraft
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V4.1.3

1. No changes for this aircraft

V4.1.2

1. No changes for this aircraft

V4.1.1

1. Fix: an alternator did not save its status properly
2. Minor fixes

V4.1.0

1. New: FSEconomy integration with the maintenance system
2. Fix: X-Plane crashed in case of airplane crash
3. Fix: the systems’ damages where updated during replay as well
4. Fix: on XP10 some message windows were not shown properly
5. Fix: on multimonitor setups the in-flight tips were shown on the wrong monitor

V4.0.3

1. Fix: the aircraft serial number is now more randomized
2. Fix: the weight and balance traded “0Lt” of fuel when changing the passengers’ masses
3. Fix: the initial status of the aircraft could not be reset properly
4. The spark plugs fouling in-flight tip is now easier to understand
5. Improved instruments behavior once weathered
6. The Tachometer Time is now only based on RPMs

V4.0.2

1. New: it is now possible to deactivate the brakes smoothing
2. Fix: fixed a crash when closing a plugin’s window
3. Better gyros behavior

V4.0.1

1. Fix: some mouse clicks were not captured properly in the Maintenance Report window
2. Fix: it was not possible to properly change the oil filter using the Maintenance Report

window

V4.0.0

1. New: Economic System
2. Improved multimonitor support
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V3.5.11

1. Vacuum Pump: the pump failure can be triggered using X-Plane failures menu
2. Attitude Indicator: the indicator failure can be triggered using X-Plane failures menu
3. Fix: changing livery or airport could not allow the aircraft to load its status properly

V3.5.10

1. Minor fixes

V3.5.9

1. The Hypoxia warning is shown only when the TUC is lower than 20 minutes

V3.5.8

1. Minor fixes

V3.5.7

1. Fix: the state loading could load incomplete data on some systems
2. Minor fixes

V3.5.6

1. Better fuel flow at startup
2. It’s now possible to paste the text in the licence box
3. Fix: saving a state file could have caused a crash on some specific system configurations
4. Fix: the static elements are better managed after leaving the replay mode
5. Fix: in some cases REP was unable to retrieve the correct system time

V3.5.5

1. Fix: In some cases the plugin was unable to recognize if the sim was paused or not. This
could lead to some major issues, such airplane crash after leaving replay mode

2. Fix: the prop governor did not react correctly when controlled using a joystick axis
3. Fix: minor fixes to the sound engine
4. Fix: in some cases the engine temps were not updated correctly if the airplane was loaded

in flight, causing the oil pump to seize
5. Fix: in some cases the liveries status were not loaded properly when changing from a livery

to another of the same aircraft
6. It is now possible to disable the advanced steering algorithm
7. Minor fixes

V3.5.4

1. Minor Fixes
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V3.5.3

1. Fix: fixed a compatibility issue with the sound engine
2. Fix: the parking brake lever was not properly set when parking brake was toggled using

X-Plane default commands.

V3.5.2

1. Fix: the new OpenAL equalizer showed some incompatibility with 3rd party plugins. This
update will try to work around them and prevent crashes. A better fix will be provided in
future releases.

2. Fix: the parking brake lever was not properly set when parking brake was toggled using
X-Plane default commands.

V3.5.1

1. Fix: the flaps handle did not move when the battery was off
2. Fix: the flaps motor sound was heard while checking the flaps during the walkaround
3. XP11.30 new hypoxia effect is now overridden and REP’s more precise hypoxia effect is

used instead

V3.5.0

1. New: It is now possible to load a worn out airplane. Checkout the Persistent Aircraft and
Components Wearing chapter.

2. New: The cockpit instrumentation wears out with time and can be fixed using the Mainte-
nance Report

3. New: Hobbs Time and Tach Time are now counted separately for the airframe and the
engines

4. New: It is now possible to move the viewpoint while in walkaround or towing mode. VR not
supported yet. See the Towing and Walkaround sections for more information.

5. The static elements, such chocks and tie-downs, are now managed during replay
6. The propeller governor dynamics at low RPMs are much improved
7. Improved starter algorithm
8. Fix: under certain conditions, the fuel pump sounds where not stopped with the pump itself
9. Fix: a bug prevented the cylinders to fail properly and to report their compressions in the

Maintenance Report
10. Fix: the hypoxia message was shown when the hypoxia was disabled
11. Fix: the oil filter get less clogged when it’s past TBO
12. Fix: the autostart broke if the weight and balance configuration was changed while it was

running
13. Fix: The Maintenance Report and the Kneeboard were not dimmed correctly at night

V3.4.6

1. New: Automatic updates via SkunkCrafts Updater plugin
2. New: REP is now compatible with the Differential and progressive brakes for X-Plane 11

plugin
3. Improved documentation
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4. Improved gyros spin-down behavior
5. Fix: failures and damages were triggered while in replay mode
6. Fix: the oil pressure needle was not visibile if the airplane was loaded with the engines

running
7. Minor improvements

V3.4.5

1. New: It is possible to manage the static elements from the plugins menu
2. New: Command to toggle the static elements
3. New: Command to fix all systems
4. New: REP correctly recognizes the engine failures triggered by X-Plane
5. Fix: In the latest X-Plane versions the in-flight tip messages may have been not shown

correctly
6. Fix: Some entries in the tech report were not clickable
7. Fix: Minor typos in kneeboard
8. The installer has been improved to work with all the airplane mods available over the

Internet
9. More realistic hypoxia effect at lower altitudes

10. Improved documentation

V3.4.4

1. Minor fixes

V3.4.3

1. New: Improved engine torque algorithm
2. New: Improved sparkplugs fouling algorithm
3. New: Removed the mouse gestures to open the kneeboard
4. New: The checklists/mass and balance/towing mode/autostart are now accessible from

the plugins menu as well as the lateral menu
5. New: a new command has been added to switch on the HI fuel pump
6. Improved multimonitor compatibility

7. Fix: oil pressure was sometimes too low
8. Minor fixes

V3.4.2

Internal test build – not released to the public

V3.4.1

1. Fix: missing input chars in textbox
2. Fix: input on multimonitor setup was not working as expected
3. Minor fixes
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V3.4.0

1. New: Experimental VR Support
2. New: SDK 3.0 (Detachable) windows
3. Improved engine model
4. Minor fixes

V3.3.1:

1. Fix: Too rich mixture at full power
2. Minor fixes

V3.3.0

1. New: 100% custom engine model to replace the internal X-Plane piston engine
2. New: Engine monitor enables engine fine tuning during flight
3. New: Improved drag model
4. New: Improved walkround oil system check
5. New: Improved ground roll sounds
6. New: Improved ADI spoolup model
7. New: Walkaround keyboard commands
8. Minor fixes

V3.2.1

1. Fix: Loading and unloading the plugin more times caused a crash
2. Fix: If the flight was started with engine running, the mixture was set to idle-cutoff
3. Minor fixes

V3.2.0

1. New: 3D sounds
2. New: Advanced gyro wander
3. New: You can now check the pitot probe temperature during walkaround
4. New: Postflight walkaround
5. New: Lights check during walkaround
6. New: More information about the cylinders status
7. New: The hobbs hour are now saved in the airplane state file and restored the next session
8. Improved steering algorithm
9. Better startup sounds

10. Fixed a bug that caused the cylinders to not being fixed correctly after an engine seizure
11. The landing gear failures are based on actual gravity acceleration. Now the landing on

sloped strips are more realistic.
12. Fix a bug that may caused the engine to not fail when it should have
13. Minor fixes and improvements

V3.1.1

1. New: The chocks and tie downs are checked before automatic start
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2. New: The lateral menu can now be completely hidden (see the plugin settings window)
3. Improved flooded engine message
4. Better compatibility with the “Start with engine running” setting
5. Fix: the label colors in some walkaround views were incorrect
6. Fix (XP11 only): the wind sound volume is controlled by the environment sounds volume
7. Minor fixes

V3.1.0

1. New: Dynamic ground roll sounds
2. Minor fixes

V3.0.0

1. New: reworked user interface and graphics
2. New: automatic startup procedure
3. Improved flight dynamics in X-Plane 11
4. Fix: some throttle quadrants did not work correctly with REP
5. Minor fixes and improvements

V2.6.4

1. New: Flight dynamics improvements in both X-Plane 10 and 11
2. Fix: Minor fixes

V2.6.3

1. Fix: The right toebrake did not couple properly with external rudder pedals
2. Fix: The oil system “Refill” button was not clickable

V2.6.2

1. Fix: Minor fixes

V2.6.1

1. Fix: Checklists typos
2. Fix: Improved fuel pump sounds
3. Fix: The wheel brakes may be stuck after towing
4. Fix: Improved engines doppler and distance sounds
5. Fix: Damages disabled during replay
6. Fix: Improved the joystick compatibility with the new propeller governor

V2.6.0

1. New: Custom propeller governor
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V2.5.1

1. Fix: Corrected the toe brakes algorithm

V2.5.0

1. New: Improved torque effect
2. New: Improved CHT and Oil Temperature algorithm
3. New: Oil temperature tips
4. New: Improved hypoxia effect & algorithm
5. New: Fuel & Oil check in walkaround mode
6. Minor Fixes

V2.4.0

1. New: Spark plugs dynamics:
• The spark plugs get fouled when the engine runs at low RPMs
• The default spark plugs can be replaced with the fine-wire ones

2. New: Hypoxia can now be disabled in the settings panel
3. New: The engine may be damaged by wrong ROP/LOP operations
4. Minor Fixes

V2.3.0

1. New: Hypoxia simulation
2. New: Oil filter simulation: need to replace it at every oil change
3. New: Oil pump damage simulation
4. New: Fuel filter simulation: need to replace it after TBO
5. New: Vacuum pump casual failure simulation
6. New: More realistic engine priming dynamics
7. New: Improved W&B simulation during flight
8. Fix: Minor bug fixes

V2.2.1

1. Fix: the installer did not apply some changes correctly

V2.2.0

1. New: Simplified installation
2. Fix: The analog and digital fuel flow gauges were not reporting the correct fuel flow under

certain circumstances
3. Fix: Minor fixes

V2.1.0

1. New: Engine pre-heating and winterization kit
2. New: The avionics settings are restored after reloading the airplane
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3. New: Better compatibility with other plugins that manage the state of the airplane (such
as X-Bookmark)

4. New: The sounds volume is controlled by the Carenado volume knob
5. New: The lateral menu is dimmed at night
6. Fix: More realistic ground physics
7. Fix: The oil system is now reporting the correct oil quantity
8. Fix: Minor fixes

V2.0.3

1. Fix: The cowl flaps lever cannot be moved using the mouse wheel
2. Fix: The kneeboard images were cutted and not shown correctly

V2.0.2

1. New: Improved cylinders physics
• The CHT temperature is now provided by a custom algorithm

2. New: Improved oil system
• The oil temperature is now provided by a custom algorithm
• The oil temperature and pressure depends also on oil quantity an quality

3. New: Improved touchdown sounds
4. Minor Fixes

V2.0.1

1. Fix: It was not possible to enter the walkaround mode if the “Cold and Dark” option was
disabled

2. Fix: Typos in the towing tips
3. Fix: The Walkaround checklists were not correctly visible on smaller screens.

V2.0.0

1. New: Custom interactive walkaround and pre-flight procedures.
2. New: Custom airplane towing system
3. New: More advanced engine physics (especially for engine startup)
4. New: More complex damages system for the avionics, the engine and the landing gear

such as:
• Oversquare operation of the engine is not always allowed
• The tire are damaged if the brakes are active on touchdown

5. New: More in-flight tips
6. New: Custom menu that provides an easy access to REP’s features
7. New: Stall buffeting effect (improved if HeadShake 1.5+ is installed)
8. Minor changes to the sounds system
9. Minor changes to the graphics system

10. Bug fixes

V1.0.2

1. New: Correct steering and ground roll physics, especially in cross wind conditions.
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2. New: The Weight & Balance tool now predicts the C.G. position at landing.
3. New: HeadShake and REP integration to better simulate the engine vibrations of the TSIO-

520 (Headshake v1.5 or higher required).
4. Fix: Improved compatibility with Saitek products.
5. Fix: Minor fixes.

V1.0.1

1. New: A tip is shown if the pilot is managing the plane’s system in the wrong manner.
2. New: Some failures (such as the avionic’s) are behaving in a more realistic way.
3. New: The parasite roll moment incorrectly reproduced by X-Plane is reduced.
4. New: The flooded engine behavior is nowmore realistic. If flooded, the engine may actually

starts with closed mixture.
5. New: Engine manufacturer and model in the Hangar window.
6. New: Better oil color report in the Hangar window.
7. New: Added the “About” menu.
8. Fix: Sometimes, the joystick mixture axis was not correctly recognized.
9. Fix: Cranking a running engine does not reduce the engine’s RPM anymore.

10. Fix: Cranking a running engine does not cause an avionics failure anymore.
11. Fix: The pilot altimeter’s barometer was rendered incorrectly.
12. Fix: The propeller joystick axis was not working as expected.
13. Fix: The oil pressure was too high during flight.
14. Fix: Minor changes to improve performance and correct typos.

V1.0.0

1. Initial Release
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LICENCE

End-User License Agreement for SimCoders.com Reality Expansion Pack

This End-User License Agreement (EULA) is a legal agreement between you (either an individual
or a single entity) and the mentioned author (SimCoders.com) of this Software for the software
product identified above, which includes computer software and may include associated media,
printed materials, and “online” or electronic documentation (“SOFTWARE PRODUCT”).

By installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree to be bounded by
the terms of this EULA. If you do not agree to the terms of this EULA, do not install or use the
SOFTWARE PRODUCT.

SOFTWARE PRODUCT LICENSE

The Reality Expansion Pack is being distributed as payware licenced software for personal,
commercial use, non-profit organization, educational purpose. It may not be included with
CD-ROM/DVD-ROM distributions. You are NOT allowed to make a charge for distributing this
Software (either for profit or merely to recover your media and distribution costs) whether as a
stand-alone product, or as part of a compilation or anthology, nor to use it for supporting your
business or customers without the written permission of the author. It may not be distributed
freely on any website or through any other distribution mechanism.

1. GRANT OF LICENSE.

This EULA grants you the following rights: Installation and Use. You may install and use an
unlimited number of copies of the SOFTWARE PRODUCT.

Reproduction and Distribution. You may not reproduce and distribute an unlimited number of
copies of the SOFTWARE PRODUCT.

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.

Limitations on Reverse Engineering, Decompilation, Disassembly and change (add,delete or
modify) the resources in the compiled the assembly. You may not reverse engineer, decompile,
or disassemble the SOFTWARE PRODUCT, except and only to the extent that such activity is
expressly permitted by applicable law notwithstanding this limitation.

Update and Maintenance

The Reality Expansion Pack minor upgrates are FREE of charge.

Separation of Components.

The SOFTWARE PRODUCT is licensed as a single product. Its component parts may not be
separated for use on more than one computer.
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Software Transfer.

You may permanently transfer all of your rights under this EULA, provided the recipient agrees to
the terms of this EULA.

Termination.

Without prejudice to any other rights, the Author of this Software may terminate this EULA if you
fail to comply with the terms and conditions of this EULA. In such event, you must destroy all
copies of the SOFTWARE PRODUCT and all of its component parts.

3. COPYRIGHT.

All title and copyrights in and to the SOFTWAREPRODUCT (including but not limited to any images,
photographs, clipart, libraries, and examples incorporated into the SOFTWARE PRODUCT), the
accompanying printed materials, and any copies of the SOFTWARE PRODUCT are owned by
the Author of this Software. The SOFTWARE PRODUCT is protected by copyright laws and
international treaty provisions. Therefore, you must treat the SOFTWARE PRODUCT like any other
copyrighted material. The licensed users or licensed company can use all functions, example,
templates, clipart, libraries and symbols in the SOFTWARE PRODUCT to create new diagrams
and distribute the diagrams.

LIMITED WARRANTY

NO WARRANTIES.

The Author of this Software expressly disclaims any warranty for the SOFTWARE PRODUCT.
The SOFTWARE PRODUCT and any related documentation is provided “as is” without warranty
of any kind, either express or implied, including, without limitation, the implied warranties or
merchantability, fitness for a particular purpose, or noninfringement. The entire risk arising out
of use or performance of the SOFTWARE PRODUCT remains with you.

NO LIABILITY FOR DAMAGES.

In no event shall the author of this Software be liable for any special, consequential, incidental
or indirect damages whatsoever (including, without limitation, damages for loss of business
profits, business interruption, loss of business information, or any other pecuniary or physical
loss) arising out of the use of or inability to use this product, even if the Author of this Software
is aware of the possibility of such damages and known defects.
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LibCURL EULA

The following statements are applicable only to the LibCURL library used to provide some
features of this product.

COPYRIGHT AND PERMISSION NOTICE

Copyright (c) 1996 - 2018, Daniel Stenberg, daniel@haxx.se, and many contributors, see the
THANKS file.

All rights reserved.

Permission to use, copy, modify, and distribute this software for any purpose with or without fee
is hereby granted, provided that the above copyright notice and this permission notice appear in
all copies.

THESOFTWARE ISPROVIDED “AS IS”,WITHOUTWARRANTYOFANYKIND, EXPRESSOR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR
A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT
SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS
IN THE SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising
or otherwise to promote the sale, use or other dealings in this Software without prior written
authorization of the copyright holder.
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